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Chapter 1 : How to make church memes and why they matter | United Methodist Communications
Find local churches in your area. You can go about selecting a church in a number of different ways, depending on your
history with religion and what's available in your area, but it's important to find a church that's close and convenient so
you can feel like part of the community.

The priest urges the penitent to have confidence in God with these or similar words: May the Lord be in your
heart and help you to confess your sins with true sorrow. The priest may read or say a passage from Sacred
Scripture after which the penitent then states: Forgive me, Father, for I have sinned. It has been however many
days, weeks, months or years since my last confession. The penitent then states his or her sins. For the
confession to be valid, the penitent must confess all of the mortal sins he or she is aware of having committed
since the last confession, be sorry for them, and have a firm purpose of amendment to try not to commit the
same sins in the future. After this, the priest will generally give some advice to the penitent and impose a
penance. Then he will ask the penitent to make an act of contrition. The penitent may do so in his or her own
words, or may say one of many memorized acts of contrition like the following: In choosing to do wrong and
failing to do good, I have sinned against you, whom I should love above all things. I firmly intend, with the
help of your grace, to do penance, to sin no more and to avoid whatever leads me to sin. Our Savior, Jesus
Christ, suffered and died for us. In His Name, O Lord, have mercy. After this the priest will absolve the
penitent in the following words: The penitent makes the sign of the Cross and answers: The priest will then
dismiss the penitent with a short prayer and encouragement. The penitent should then immediately try to fulfill
the penance imposed if it is something that can be done quickly. The questions below should assist you in
making a thorough review. Tell the priest the specific kind of sins you have committed and, to the best of your
ability, how many times you have committed them since your last good confession. Avoid generalizations and
inform the priest of any relevant circumstances in which your sins were committed. You are obliged to confess
only mortal sins, since you can obtain forgiveness for your venial sins by sacrifices, acts of charity, prayer and
other pious actions. Confession of venial sins, however, is very helpful for avoiding sin and advancing in
holiness toward Heaven. If you are in doubt about whether a sin is mortal or venial, mention your doubt to the
priest. For a sin to be mortal, three conditions must together be met: Examination of Conscience Catholics for
centuries have found it profitable to examine their consciences in light of the Ten Commandments. Penitents
are encouraged to expand on them in their prayerful review of their conduct. Click on each commandment to
view the examination aids. You shall not have strange gods before Me. Have I made time for God each day in
prayer? Have I denied my faith in God or endangered it by practices of the occult or through reading or
programs that are opposed to faith and morals? Have I tried to learn and understand my faith better? Have I
denied my faith before others? Have I been willing to affirm, defend and practice my faith in public and not
just in private? Have I offended God by blasphemy, cursing, or treating his name carelessly? Do I try my best
to fulfill the promises and resolutions that I have made toward God, especially those of my Baptism and
Confirmation? Have I shown disrespect for the Blessed Virgin Mary, the saints, the Church, holy things or
holy people? Have I fully, consciously and actively participated in Holy Mass or just gone through the
motions? Have I given my full attention to the Word of God or have I given in easily to distractions? Have I
arrived at Mass late due to carelessness? Have I left early without a serious reason? Have I kept the
Eucharistic fast before Holy Mass? Have I received Holy Communion in a state of mortal sin? Did I do work
on Sunday that was not necessary? Have I failed to be grateful for the sacrifices my parents have made for
me? Have I disrespected my family members, treated them with scant affection, or reacted proudly when
corrected by them? Did I cause tension and fights in my family? Have I cared for my aged and infirm
relatives? Have I provided for the Christian education of my children through Catholic school or religious
instruction? Do I inspire them by my virtue or scandalize them by my failings? When I have disciplined my
children, did I do so with charity and prudence? Have I encouraged my children to pray about their why God
created them, and whether God may be calling them to the priesthood or religious life? Did I attempt suicide
or entertain thoughts of taking my life? Did I have an abortion, or encourage or help someone else to have
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one? Have I participated in the practice of abortion through my silence, financial support for persons or
organizations that promote it, or voting without a very serious reason for candidates who support it? Have I
abused my children or others in any way? Have I mutilated or harmed my body? Have I borne hatred or
withheld forgiveness? Have I neglected my health? Did I give bad example through drug abuse, drinking
alcohol to excess, fighting, or quarreling? Have I easily gotten angry or lost my temper? Did I willfully
entertain impure thoughts or desires? Did I deliberately look at impure TV programs, computer sites, videos,
pictures, or movies? Did I commit impure acts with myself masturbation or with others through adultery sex
with a married person , fornication premarital sex or homosexual activity? Have I been faithful to my husband
or wife in my heart and in my conduct with others? Have I sinned through the use of contraception,
contraceptive sterilization, or in-vitro fertilization? Have I touched or kissed another person in a lustful way?
Have I treated others, in my deeds or thoughts, as objects? Have I been an occasion of sin for others by acting
or dressing immodestly? Am I married according to the laws of the Church? Did I advise or encourage anyone
to marry outside the Church? Have I made acquiring material possessions the focus of my life? Am I
inordinately attached to the things of this world? Did I steal, cheat, help or encourage others to steal or to keep
stolen goods? Did I receive stolen goods? Have I returned or made restitution for things I have stolen? Have I
paid my debts or have I played the system so as to avoid fulfilling my obligations? Have I cheated my
company? Have I paid a fair wage to anyone who works for me? Have I been faithful to my promises and
contracts? Have I given or accepted bribes? Have I allowed work to get in the way of my obligations to God or
to my family? Do I generously share my goods with the needy? Am I generous to the work of the Church? Do
I share my time, talents and treasure in the apostolic and charitable works of the Church and in the life of my
parish? Have my lies caused spiritual or material harm to others? Have I told lies about anybody calumny?
Have I injured others by revealing true hidden faults detraction? Did I commit perjury? Have I been guilty of
refusing to testify to the innocence of another because of fear or selfishness? Have I engaged in uncharitable
talk or gossip? Have I encouraged the spread of scandal? Am I guilty of any type of fraud? Did I insult or
tease others with the intention of hurting them? Have I falsely flattered others? Have I made rash judgments
about others? Did I fail to keep secret what should be confidential? Other Sins Did I intentionally refuse to
mention some grave sin in my previous confessions? Have I fulfilled my obligation to go to confession at least
once a year and of going worthily to Holy Communion at least during the Easter season?
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Chapter 2 : How to Organize and Produce a Church Photo Directory for free | blog.quintoapp.com
It is popular today for people to say, "Don't go to church; BE the church." Everybody nods their heads at this, but few
actually know what it means or how to truly "be the church." With this post, Sam Riviera is starting a series of posts on
how to be the church in your community. If you.

It is a great aid for pastors and families to remember who is who The entire congregation can benefit from
photo directories, in that they can keep in touch with other people easier, and learn about others in the
community. Staff members find the photo directories invaluable in that they can add notes to certain people,
and then visually remember what role s those individuals play within the Church Producing a photo directory
is rather easy, but here are a few things you should do first. As well, of course you want everyone wearing
their Sunday Best! Find someone to take pictures. You can either find someone within the congregation, or
hire a professional photographerAdvantages of in-house photography is that you can save some money, i.
Plus, nowadays, pretty much any digital camera can take the kind of quality pictures that you need.
Professional photographers generally know how to bring out the best smiles in individuals, plus know what
kind of lighting is necessary to create the best looking pictures. So you should decide whether someone within
the congregation has the expertise you need to take high quality photographs, or look at hiring someone else.
Send out an e-mail reminder to remind individuals and families of the photo shoots, or announce it several
weeks in advance, every Sunday. For example, if you wanted a photograph on the left hand side, and text on
the right, you would make it two columns. Resize them so they fit, and add the information. Make sure you
organize everything alphabetically! Add pertinent information, such as the names, addresses, and phone
numbers of the families you wish to add. Alternatively, if time is important to you, and you want something
that you can edit easily later on down the road, you might consider a professional photo directory application.
Advantages include the following: It is much faster, you just import the photographs, and then the software
automatically resizes it. Doing it manually might take a while, because you would need to shift everything
around. Doing it by hand would take some time Plus many more benefits, depending on your needs Creating a
church photo directory is a pretty simple and straightforward process. Then, download all the photographs to a
computer, import them into a wordprocess or a photo directory application. Organize it, print it off, and then
enjoy all the compliments you get for a beautiful photo directory! Play Now Play in Popup.
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Chapter 3 : How Evangelization Happens - Go and Make Disciples
Maybe you should go by the church faster, as in not turn in Usually, if you're enjoying something you're not in a hurry to
see it end Maybe you're in the wrong church, wrong religion, or simply not a person who benefits from religion.

My experiences in churches nationwide, together with my years of teaching a seminary course on worship,
cause me to think a great deal about the worship of God in the local church. One observation I have made is
that most churches could make dramatic improvements in the quality of their worship event by making some
changes that are relatively simple. After a quarter-century of pastoral ministry and leading worship services, I
do realize why "simple" changes are sometimes difficult to make. However, if you are a leader who senses the
need for freshness in worship, you should consider these recommendations because a they each have a direct
or indirect biblical basis, b they are specific enough to be practical, and c they can be accommodated to any
church, regardless of size, location, culture, or worship style. Focus on God in every element in worship.
Worship is, by definition, the worship of God. Go through your order of service and ask of every element,
"Does this focus on God? Schedule them just before or after the time when God is the exclusive focus. Have
clear Biblical support for every element in worship. Go through the order of service once more and ask of
every element, "Is there a Biblical basis for doing this in worship? This differs from a circumstance of
worship, such as the time the service begins, its length, the color of the carpet, whether you use air
conditioning or microphones, etc. Come before the Lord with the confidence that everything you do in
worship has a Biblical command, example, or clear inference which supports it as a worship activity.
Discontinue every part of your public worship for which you can find no solid scriptural foundation. If
churches practiced just these first two principles, great reformation would occur in their worship. The Bible
not only tells us the "what" of worship, but also something about the "how. To offer them "in faith" Hebrews
And while none of these can be coerced, the worship leader can do something to contribute to an atmosphere
of "reverence and awe. Smile, even laugh when it would seem that Jesus Himself would do the same. One of
the best ways of nurturing "reverence and awe" among worshipers is simply to insure that each element of
worship focuses their attention on God see recommendation number one. Many Bible-believing men think
they are preaching the Bible when they are not. There is a difference in preaching that is consistent with the
Bible and preaching which evidently comes from the text. For example, a man who announces Psalm 23 as his
text, and then preaches about the importance of baptism and the evil of abortion may be proclaiming truth that
is consistent with the Bible, but he is not preaching the message of Psalm Crossway Books, , page Preachers,
whether your passage is a single text, a paragraph, or an entire chapter of Scripture, preach in such a way that
your words are obviously exposing, illustrating, and applying the point of that passage. It amazes me how
many men who fight and rightly so for the inerrancy of Scripture do not read the Bible publicly, except
perhaps for their brief sermon text. One of the easiest ways to go about giving attention to the public reading
of Scripture is to read consecutively through books of the Bible. Choose a book and read a chapter each week.
If a chapter is particularly long, take half this week and the other half the next. When you hear people on radio
who read naturally but well, identify and learn from what makes them easy to listen to. Read the Bible in such
a way that reflects "reverence and awe" for the Lord and His Word. Words well read are appealing. Those read
poorly and heartlessly are not. I was in an hour-and-fifteen minute worship service recently which had two
minutes of prayer. A friend told me of attending a well-known, evangelistic church which had two prayers
totaling less than thirty seconds. Prayerless worship may be an oxymoron, but it is increasingly common in the
contemporary evangelical church. True, unbelievers present will find prayer boring, but why should we let the
spiritually dead dictate the prayer life of the body of Christ? Can you imagine the apostles and the first century
church having worship without prayer? As you think of rebuilding the public prayer life of the church, keep in
mind that the worship experience of everyone in the congregation probably could be improved by one short
session of training on praying publicly. Transition smoothly between elements of worship. This is an
application of the inspired words of the Apostle Paul, "But all things must be done properly and in an orderly
manner" 1 Corinthians Without a smooth and orderly transition between them, too many worship elements
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are often left to stand alone, unconnected to anything else in the service. When making transitions, remember
that briefer is usually better. When planning them, think sentence or paragraph-length at most. Above all think
"purpose and flow. Not every element needs a transition into it the sermon, for instance. Some transitions need
not mention the previous activity. After singing a hymn, it would be appropriate to say, "Take your Bible and
turn to Matthew In our consecutive reading of the book of Matthew we have come to chapter ten. Please listen
as I begin reading at verse one. Then consider these next recommendations: Do as much as possible
congregationally. Our entertainment saturated culture has soaked into the church. In growing numbers of
churches, the congregational worship of God has been degraded into a parade of individual religious
performances to be applauded. Biblical worship involves the whole congregation, prompted by worship
leaders, focusing on and responding to God. Every believer present should engage in worship, not observe it.
Never let worship decompose into a vicarious experience where the many in the congregation merely watch
the few on the platform who at best are worshiping, and at worst are performing. Have congregational singing
with musical accompaniment, not music with congregational accompaniment. Parenthetically, drums are
especially problematic in this regard. If you have them, keep them from dominating the music. Evaluate your
worship service each week with several leaders. Over a snack together on Sunday night, each person is
required to make at least a brief comment about every element in the worship service s of that day. The result
is a constant vigilance and care about the quality of their worship experience. The evaluation also fosters an
ongoing thoughtfulness and intentionality about everything in the service. As a byproduct, some future
worship leaders i. Customize the idea to your own situation. Sunday night may not work for you, but waiting
too long dims the memory. Instead of staff and interns you may need to choose trusted lay leaders, or even an
ad hoc group each time. Make sure to involve as many of the worship leaders as possible as often as possible,
for they all need reinforcement or redirection now and then. And sometimes hearing more than one person
make the same comment or hearing a familiar comment from a different person makes a deeper impression. If
anything is worth doing well, it is the worship of our glorious God. If anything in the life of the church is
worth the cost of reformation, it is the worship of our holy God. All the information contained on the
SpiritualDisciplines. Permission granted to copy this material in its complete text only for not-for-profit use
sharing with a friend, church, school, Bible study, etc. No portion of this website may be sold, distributed,
published, edited, altered, changed, broadcast, or commercially exploited without the prior written permission
from Donald S. Written permission to publish on www. Whitney or to see his web site, visit
SpiritualDisciplines. View the additional articles Don has written on this subject:
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Chapter 4 : 10 Ways to Improve Your Church Worship Service
Some "church crafts" that might be appropriate are: Ribbon Bookmarks. These are quiet, easy to make, and don't take
long, so if the sermon gets interesting, you can just quietly put it away.

I liked the Sunday School From a Sunday morning service to a youth skating party. You never know when
someone will be there that is just waiting for an opportunity to hear the gospel and accept Christ as their
Saviour. The reason that any church should have any function is to bring people to hear the gospel. If they are
not giving the Gospel for people to have an opportunity to trust Christ as their Saviour, they are no better than
the social club down the street. They should be a friendly church. Most people can tell if putting on an act. The
pastor must preach at a level that you can understand. Some preachers try to impress people with their
education by using big words in a sermon. It is OK for a preacher to use big words if he will tell you what they
mean. If he does this, he is educating you. A good preacher is not just one that can talk to the small child or to
the college professor, but one that can preach to them both at the same time and they will both understand him
and learn from what they are hearing. Remember that you can teach without preaching but you should never
preach without teaching. It should be a church where you would need to bring your Bible. It was a feel good
message that I could have heard anywhere from any motivational speaker. How to get more out of church.
Here are some tips to help you to get more out of the church service once you find a good church. Go there
expecting to receive a blessing from the church. Bring your Bible to church. Read your Bible during the week.
Pray during the week and before church that God will bless the speaker. Also that God will open your heart
and mind to what He would have you to learn. Invite other people to come to church. This is the responsiblilty
of every Christian. Expect for God to work in your life. Have Bible studies with your spouce and children
during the week. Write down notes during the sermon so you can refer to them later. Start preparing for the
next church service when you leave this service. Any comments or questions? Feel free to e-mail us.
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Chapter 5 : Making a Good Confession - The Light Is On For You
Note: Citations are based on reference standards. However, formatting rules can vary widely between applications and
fields of interest or study. The specific requirements or preferences of your reviewing publisher, classroom teacher,
institution or organization should be applied.

The Holy Spirit is the fire of Jesus. The Spirit, the first gift of the risen Christ to his people, 31 gives us both
the ability to receive the Gospel of Jesus and, in response, the power to proclaim it. Without the Holy Spirit,
evangelization simply cannot occur. In the Life of the Church We cannot really talk about the "ordinary" life
of the Church because all of it is the graced gift of the Holy Spirit. Yet there are familiar ways by which
evangelization happens: In daily life, family members evangelize each other; men and women, their future
spouses; and workers, their fellow employees, by the simple lives of faith they lead. Through the ordinary
patterns of our Catholic life, the Holy Spirit brings about conversion and a new life in Christ. Here, there are
two elements at work: Certainly, our families, parishes, associations, schools, hospitals, charitable works, and
institutions give a powerful witness to the faith. But do they share it? Does their living faith lead to the
conversion of minds and hearts to Jesus Christ? Does the fire of the Holy Spirit blaze in them? In Sharing the
Gospel with Others The Holy Spirit also evangelizes through our attempts to reach those who have given up
the practice of their Catholic faith for one reason or another and those who have no family of faith. Many in
our Catholic community know family members, friends, and neighbors who do not have or practice faith.
Millions of Catholics no longer practice their faith. Although many of them may say they are Catholic, they no
longer worship with the community and thereby deprive themselves of the gifts of word and sacrament. Some
were never formed in the faith after their childhood. Some have drifted away because of one or another issue.
Some feel alienated from the Church because of the way they perceive the Church or its teaching. Some have
left because they were mistreated by church representatives. As a community of faith, we want to welcome
these people to become alive in the Good News of Jesus, to make their lives more fully a part of the ongoing
story of salvation and to let Christ touch, heal, and reconcile them through the Holy Spirit. We want to let our
inactive brothers and sisters know that they always have a place in the Church and that we are hurt by their
absenceâ€”as they are. We want to show our regret for any misunderstandings or mistreatment. And we want
to help them see that, however they feel about the Church, we want to talk with them, share with them, and
accept them as brothers and sisters. Every Catholic can be a minister of welcome, reconciliation, and
understanding to those who have stopped practicing the faith. Our plan also asks Catholics to reach out to
those who do not belong to a faith community and to invite them to consider the power of the Gospel of Jesus,
which the riches of the Catholic Church can bring into their lives. Perhaps this may seem the most difficult of
all the tasks evangelization asks of us. Yet if we have once seen the joy of those received into the Church at
Easter, if we have ever experienced the growth of those going through the Rite of Christian Initiation of
Adults, if we have ever seen someone thrilled with the Gospel for the first time in his or her life, we know that
this is, in truth, one of the sweetest gifts of the Spirit. The Holy Spirit, through the ecumenical movement, is
calling churches and ecclesial communities into ever-deeper communion through dialogue and cooperation.
We look forward with great eagerness to the day when all are members of one family. While recognizing that
the life of other Christian communions can truly bring about a life of grace, we nevertheless cannot ignore all
that still divides us. Our love for all who confess Christ and our desire for unity compel us to share with them
the fullness of revealed truth that God has entrusted to the Catholic Church and to learn from them expressions
of the truths of faith that other churches and ecclesial communities share with the Catholic Church. Those who
have not received the Gospel deserve honor and respect for following God as their consciences direct them.
They are related to the People of God in a variety of ways. First are the Jews, the Chosen People, to whom the
covenants and promises were made and who, in view of the divine choice, are a people most dear to God.
People of other non-Christian religions also have the right to hear the Gospel, as missionaries have brought it
over the centuries. Interreligious dialogue presents an opportunity to learn about other religious traditions and
to explain our own. Such dialogue, however, must never be a camouflage for proselytizing. Rather, it should
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be approached with utmost respect and sensitivity. Catholics earnestly share their faith in Jesus Christ, which
gives meaning to their lives, praying for that good day, known to God alone, when all peoples will address the
Lord in a single voice and serve God with one accord.
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Chapter 6 : How To Go To Confession | CatholicTV
Believe it or not, memes and marketing go hand-in-hand. So, here are a few ways that you can take advantage of their
popularity to promote the ministries of your church. So, here are a few ways that you can take advantage of their
popularity to promote the ministries of your church.

Do you really want to grow? If the answer is yes, then you must commit to this goal and be willing to accept
changes. And the people in your congregation must also be willing to accept changes. In order for a church to
grow, some things have to die. Those who had intimacy with the pastor have to learn to share him with new
people. They have to be willing to let go of the control they have in certain decisions and in certain areas. It
takes an incredible unselfishness. They must be willing to die to some traditions, to some feelings, to some
relationships in order for the Kingdom of God to be advanced. That takes a lot of maturity. You must be
willing to change from minister to leader. If everything depends on you â€” if you have to personally minister
to every person in your church â€” then the church cannot grow beyond your own energy level. And that is a
barrier! You become a bottleneck, an obstacle to growth. This is called the Shepherd-Rancher Conflict. As the
pastor of a little church, you know everybody; you do all the praying, all the baptizing, all the teaching; you
know every family, every kid, every dog and cat; and you shepherd everybody personally. As the church
grows, you must change roles from Shepherd to Rancher. The Rancher helps oversee the under-Shepherds.
You must be willing to let other people share the ministry. You must begin to specialize the staff under your
leadership. Plan a big day â€” an event â€” and your numbers go up. Yes, they go back down afterwards, but
not as far as they were before the event. Keep doing this and you grow. Big holidays are an obvious time to
concentrate on events â€” Easter, Christmas. Plan outreaches to the community. Cells become tools for caring
for the body. In fact, many churches build too small, too fast. May God bless you and anoint you as you begin
to implement these changes. Pastor Rick started The PEACE Plan to show the local church how God works
through ordinary people to address the five global giants of spiritual emptiness, self-serving leadership,
poverty, disease, and illiteracy. He is also the founder of Pastors.

Page 9

DOWNLOAD PDF HOW TO MAKE THE CHURCH GO
Chapter 7 : ChurchPOP | Make holy all the things!
Instead, use your church's technology to create a more social atmosphere. For instance, create an app with live surveys
during the service. Ask a question and let members provide feedback in real time.

After Confession The Basic Requirement The basic requirement for a good confession is to have the intention
of returning to God and to acknowledge my sins with true sorrow before the priest. In many ways our society
has lost a sense of sin. As a Catholic follower of Christ, I must make an effort to recognize sin in my daily
actions, words and omissions. The Gospels show how important is the forgiveness of our sins. Lives of saints
prove that the person who grows in holiness has a stronger sense of sin, sorrow for sins, and a need for the
Sacrament of Reconciliation or Confession. Pope Francis has spoken often of how important this Sacrament is
for growth in holiness and admits that he goes to confession about twice a month. The consequences of this
weakness and the inclination to evil persist, and we often commit personal or actual sin. Actual sin is sin
which people commit. There are two kinds of actual sin, mortal and venial. Mortal sin is a deadly offense
against God, so horrible that it destroys the life of grace in the soul. Three simultaneous conditions must be
fulfilled for a mortal sin: Remember thisâ€¦ If you need helpâ€”especially if you have been away for some
timeâ€”simply ask the priest and he will help you by "walking" you through the steps to make a good
confession. Before Confession Be truly sorry for your sins. The essential act of Penance, on the part of the
penitent, is contrition, a clear and decisive rejection of the sin committed, together with a resolution not to
commit it again, out of the love one has for God and which is reborn with repentance. The resolution to avoid
committing these sins in the future amendment is a sure sign that your sorrow is genuine and authentic. This
does not mean that a promise never to fall again into sin is necessary. A resolution to try to avoid the near
occasions of sin suffices for true repentance. Examination of Conscience Before going to Confession you
should make a review of mortal and venial sins since your last sacramental confession, and should express
sorrow for sins, hatred for sins and a firm resolution not to sin again. A helpful pattern for examination of
conscience is to review the Commandments of God and the Precepts of the Church: An Examination of
Conscience based on the Ten Commandments 1. You shall have no other gods besides the Lord your God. Do
I love God above all things? Do I pray often? Have I ever committed perjury, that is, lied under oath in a court
of law? Have I ever lied after "swearing to God" that I am telling the truth? Keep the Sabbath day holy. Honor
your father and your mother so that you may live long and flourish. Do I disobey my parents? Do I fail to
respect them? Do I swear at them? Am I ashamed of them? Do I let them know I love them? Do I take care of
them if they are elderly or sick? Do I lie to them? Do I steal from them? Do I skip class? Do I lie to my
teachers? You shall not kill. Am I killing myself by taking illegal drugs, such as marijuana? Have I had an
abortion? Have I ever counseled anyone to have an abortion? Have I used abortion-inducing contraceptives or
encouraged anyone to do so? Have I sterilized myself in any way or encouraged anyone to do so? Did I
participate in or approve of euthanasia or "mercy-killing"? Do I nurse anger against anyone?

Page 10

DOWNLOAD PDF HOW TO MAKE THE CHURCH GO
Chapter 8 : How to Use Microsoft Word to Make a Church Bulletin | blog.quintoapp.com
We also need to make sure that we are going to church to meet Jesus and not because it is the religious thing to do. I
believe we have a good number of prayer warriors that are praying at our church for the people that He brings to us.

Share on Facebook Microsoft Word supports a variety of templates that can help you create unique
documents, including church bulletins. After downloading a generic template, you can customize it with
images, scriptures and other personal touches to make it fit the style and temperament of your church. You can
also download bulletin templates from other sites and customize these in Word to make the fit just right.
Bulletins provide a quick way for visitors to learn about your church. Alternatively, you can download a
template from a third-party website -- just make sure it is in a Word format. Step Type "church bulletin" in the
search box provided and press "Enter" or click the magnifying glass icon. You can also type "newsletter" to
get different results that may better fit your church. Video of the Day Step Double-click the template you want
to download. As of June , Word had only one church service template available: Church service bulletin
folded. If you plan to use this template more than once, save it with a general title, such as "Church Bulletin
Template. Optional Customization to Your Bulletin Step Select the image at the top of the bulletin and replace
it with a picture of your church, congregation or other relevant image. Change its size by dragging the corners
of the image to the size you desire. Step Crop any borders or edges from your image by clicking the photo
itself. Click "Picture Tools," "Format" and then "Size. Step Replace the default scripture with the selected
readings for your service. Consider taking a small portion of the readings and adding it to a new text box as a
quote for your readers. You can add additional text boxes using the "Text Box" icon on the Insert tab. Step
Double-click the header at the top of the first page and add the name of your church, the date of the service
and any other information specific to that bulletin. This can include information around celebrations, holidays
or the name of a guest speaker. Step Customize the fonts and colors of your bulletin by using a new Word
style found in the Design tab. Styles have their own heading and body text defaults. When you select a new
style from the list on the Design tab, Word applies the changes to your entire document. Step Change the
colors of your document to match the season, such as Advent, Easter or Christmas, by clicking the "Colors"
icon on the Design tab. You can select from pre-made color combinations or choose your own. Choosing
colors that differ from your background can make text that stands out and is easier for older members to read.
Chapter 9 : 10 Ways to Make Visitors Feel Welcome at Your Church
If you are in a church where it wouldn't make any difference if you brought your Bible or not, you are probably in the
wrong church. I visited a church one Sunday where the Pastor didn't preach from any scripture and he didn't quote any
verses from the Bible.
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